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Chapter 1 

Introducing ACTIVE Data Governor 

ACTIVE Governance both documents and enforces business controls, enabling 
users to demonstrate regulatory compliance and to promote operational efficiency. 
An ACTIVE Governance Platform fulfills the documentary purpose, maintaining a 
“control library” in which users describe and catalog controls as well as other items 
that establish the business context in which controls exist. The Platform also pro-
vides for the review of control-library items, and for reporting on their status. 

Moreover, the Platform serves as a foundation for three modules that provide the 
capability to automate the enforcement of controls. One of these modules is ACTIVE 
Data Governor, which applies change control to Oracle Applications form fields. It 
can apply any of three “control types,” which subject field-value changes to increasing 
degrees of review: 

• Audit: ACTIVE Data Governor tracks changes to fields, and presents a history 
of those changes in reports. However, this control type allows users to make 
changes freely. 

• Reason Code: ACTIVE Data Governor once again tracks field changes and pre-
sents change history in reports. Moreover, when a user changes the value of a field, 
ACTIVE Data Governor requires the user to enter a reason code and may send 
notification of the change to another person or role (if a recipient of the notifica-
tion has been specified). Approval is not required for the change to be made. 

• Approval: ACTIVE Data Governor again tracks changes to field values and pre-
sents change history in reports. When a user changes the value of a field, ACTIVE 
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Data Governor not only requires the user to give a reason for the change, but also 
sends a request for approval to a specified person or role. The change must be 
approved or rejected, and the requesting user must acknowledge an approval. A 
change is implemented only when it is approved and acknowledged. 

ACTIVE Data Governor enforces rules — one for each field — to implement these 
controls. You can use a form called the AppsControl Wizard to view these rules or to 
create them manually. As an alternative to creating individual rules, you can upload 
already-created rules from a “content spreadsheet,” and then use the Wizard to con-
firm that they have been uploaded correctly. LogicalApps provides more than 1,500 
change-control objects that you can tailor to your organization’s needs. 

Note 
ACTIVE Data Governor runs within the Oracle ERP environment, using 
forms labeled “AppsControl.” This is an older name for the application that 
has become ACTIVE Data Governor. The two application names are essen-
tially interchangeable. 

Before You Start 
Before you use ACTIVE Data Governor to set up change control, make sure you 
have done the following: 
• In Oracle Applications, use the auditing feature available from the System Admin-

istrator responsibility to create audit groups and include database tables in them. 
In ACTIVE Data Governor, you will select fields that are to be subject to con-
trol rules, as well as the form blocks in which those fields reside. Each block cor-
responds to a database table, and each field in the block corresponds to a column 
in the table. For each block containing fields you want to control, you must include 
the corresponding table in an audit group. For each field you want to control, 
you must enable auditing for the corresponding column. 
If you attempt to use the AppsControl Wizard to create a control rule without 
first having set up auditing, you will encounter error messages and will be unable 
to finish configuring the rule. If you attempt to load rules from a content spread-
sheet, all rules will fail to load if auditing is incorrectly set up for even a single 
field affected by one of the rules. 

• In AppsFlow, define workflow roles to be used for notifications and approvals of 
field-value changes. See Appendix A for information on creating workflow roles. 

• In AppsForm, use the Event Tracker to “capture” information about forms, 
blocks, and fields you want to control. This enables the AppsControl wizard to 
present the information for selection as you configure control rules. See Appen-
dix B for information about using the Event Tracker. 

Note 
LogicalApps AppsForm and AppsFlow are distinct products from ACTIVE 
Data Governor. However, their workflow role and Event Tracker features 
can be used in conjunction with ACTIVE Data Governor, as described in  
Appendices A and B.  
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Chapter 2 

Creating Control Rules Manually 

The AppsControl Wizard enables you to create new control rules. As an alternative, 
you can upload already-created rules from a “content spreadsheet” (see Chapter 3). 
In the Wizard, you can also view existing rules, either to modify them or to confirm 
that content-spreadsheet rules have been uploaded correctly. 

Starting the AppsControl Wizard 
To start the AppsControl Wizard: 

1 Log on to Oracle Applications. 

2 Select the LogicalApps responsibility in the Oracle Applications list. (Ensure first 
that the LogicalApps responsibility is available to you.) 

3 A selection of LogicalApps applications appears. Click on the AppsControl 
option. 

Both the AppsControl Wizard and an AppsControl Find form appear on screen, 
with the Find form initially active. 

If you close the Wizard, you can restart it by double-clicking on the AppsControl 
option in the LogicalApps Navigator that remains on your screen. (Or, click on the 
option once, and then click on the Open button.) 
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Finding Control Rules 
When you start the AppsControl Wizard, a Find form is initially active: 

 
If you intend to create new control rules, you can simply click on its New button; in 
this case, the Wizard becomes the active form but displays no rule data.  

However, you can also use the Find form to load existing control rules into the 
AppsControl Wizard: To search for all rules, simply click on the Find button. Or, to 
search for a selection of rules, supply values in any combination of the filtering fields: 

• Application Name: From the list, select an Oracle Application containing fields 
for which you want to view control rules. Or, leave the box blank to select all 
applications. 

• User Form Name: This box presents a list of the form names that are visible to 
the user of an Oracle Application. Choose one containing fields for which you 
want to view control rules. Or, leave the list box blank to select all forms. 

• Form Name: This box presents a list of the form names that are used internally by 
the system. If you’ve made a selection in the User Form Name box, ACTIVE Data 
Governor automatically fills this box with the corresponding system form name. If 
you make a selection in this box, it overrides the value in the User Form Name box 
— ACTIVE Data Governor displays fields from the form identified by the system 
form name. You can leave this box blank to select all forms. 

• Block Name: From the list, select a form block containing fields for which you 
want to view control rules. Or, leave the box empty to select all blocks in a form (if 
you selected one in the Form Name or User Form Name box), or all blocks in all 
forms (if you made no form-name selection), or all blocks in all applications (if 
you made no application selection). 

After entering values, click the Find button. Or, to discard the filtering selection you 
have made and start over, click on the Clear button. 

After being used, the Find form remains open in the background. To bring it to the 
foreground and use it again, click on it (drag any other forms, such as the Wizard, 
out of the way). If you close it, you can reopen it: Click on View in the menu bar, 
then on Find in the View menu. Or, click on the Find icon, located second from the 
left in the tool bar. (It looks like a flashlight.) 
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Creating Control Rules 
To create a control rule in the AppsControl Wizard, first create an empty row in the 
upper grid of the form that appears when the Change Element tab is selected. If you 
clicked on the New button in the Find form, you’ve already accomplished this. Other-
wise, use any of the following methods: 
• If the Change Element grid contains any empty rows, click in the first one. 
• Click on the New button, which is first on the left in the tool bar.  
• Click on File in the Oracle Applications menu bar, then New in the File menu. 

 

Selecting a Block of Controllable Fields 
In the empty row you’ve created (in the upper grid under the Change Element tab), 
specify a block of fields in an Oracle Applications form. Enter values in these fields:  
• Form Name: This box accepts form names that are used internally by the system. 

Select one containing fields for which you want to create control rules. When you 
make a selection in the Form Name box, ACTIVE Data Governor inserts cor-
responding entries in the User Form Name and Application Name boxes. 

• User Form Name: This box accepts user form names (those visible to the user of 
an Oracle Application). If you selected a Form Name, ACTIVE Data Governor 
inserted the User Form Name here. If you select a User Form Name first, ACTIVE 
Data Governor inserts a value for Form Name, but not Application Name. 

• Application Name: This box accepts the name of the Oracle Application that 
uses the form you specified in the previous two boxes. If you began by making a 
selection in the Form Name box, ACTIVE Data Governor inserted the Applica-
tion Name here. If you began by making a User Form Name selection, type an 
application name here. Or, click in the Form Name box, then in any other box in 
the row to have ACTIVE Data Governor generate the appropriate value. 

• Block Name: This box accepts the names of field blocks that appear in the form 
you have selected. Choose the block that contains fields for which you want to 
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create control rules. You must use the Event Tracker in AppsForm before per-
forming this step. Otherwise, no block values appear in the Block Name box. 

 
Note 
You can type values into the User Form Name, Application Name, and 
Block Name boxes. However, use caution; if you enter an incorrect value, 
change tracking is not properly enabled. 

• WVR Enabled: You must select the check box if you have chosen a form (in the 
Form Name field) associated with a When Validate Record event. Clear the check 
box if the form is not. Generally, ACTIVE Data Governor selects or clears the box 
appropriately for the chosen form, and you should accept the default setting. 

If a form is associated with a When Validate Record event and the check box is 
selected, ACTIVE Data Governor applies the control rules you create when a 
user attempts to save changes to any controlled fields on the form.  

If the form is not associated with a When Validate Record event and the check 
box is cleared, ACTIVE Data Governor write-protects the fields for which you 
create Reason Code or Approval control rules. The user can then modify each 
field value in the AppsControl Change Request form (see page 17). 

Creating Control Rules for Fields in the Selected Block 
In the lower grid of the AppsControl Wizard, select individual fields and enter 
control-rule values for them. In each row of this grid, you can select values for one 
of the fields in the block you specified in the upper grid.  

1 Ensure that the Change Details tab is selected, then enter these values: 

• Field Name: Enter the name by which the underlying code calls the field you 
want to control. Select from the list (items are available if you have used the 
Event Tracker in AppsForm to capture them; see page 25), or type a value. 

• User Field Name: ACTIVE Data Governor selects a user field name (the 
label visible to the user of an Oracle Application) corresponding to the Field 
Name you selected in the previous box. You can replace it with another value. 
This name appears in the Change Request form and in notifications. 

• Control Type: Select the level of control you want to apply to the field — 
Audit, Reason Code, or Approval. For control-type definitions, see page 1. 

• WorkFlow Role: Select the person or role who reviews changes made to the 
field. For the Approval control type, you must enter a WorkFlow Role value; 
it designates the person who approves changes. For the Reason Code control 
type, you may enter a WorkFlow Role value to designate a person notified of 
the change. WorkFlow Role does not apply for the Audit control type. 

• Reason Type: Select the name for a group of reason codes (see “Creating Rea-
son Codes” on page 8). A user who changes the Oracle Applications field can 
apply any reason code belonging to the group you select here. You must select 
a reason type if you selected the Approval or Reason Code control type; a 
Reason Type selection does not apply if you selected the Audit control type.  
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• Enable: To set a change-control rule to be active once it has been generated, 
select the Enable check box to the right of its row. Clear the check box (and 
respond to a confirmation message) to turn off the rule. Or, select or clear the 
All check box (at the upper right of the Change Details panel, in the Enable 
column) to enable or disable all rules currently displayed in the panel. 

• Enable Visual Attributes: Select the check box to cause the controlled field to 
appear in yellow on its Oracle Applications form. Clear the check box to allow 
the field to remain visually undistinguished from other fields. This option applies 
only to fields controlled by Reason Code or Approval rules. 

• Comments: Explain the business risk addressed by the rule you are creating.  
2 Click on the Column Translations tab. 

• Under User Field Name, ACTIVE Data Governor supplies the display name 
of the field you want to control (it’s a copy of the value in the User Field 
Name box of the Change Details tab). You cannot change this value. 

• Under Column Name, select the name of the database column that corre-
sponds to the value entered in User Field Name — the column that stores 
data entered in the field.  
If you have not enabled auditing for the column in Oracle Audit (see page 2), 
ACTIVE Data Governor presents an error message, and you cannot complete 
the rule. You must close the Apps Control Wizard, use Oracle Audit to enable 
auditing for the column, and then return to Wizard to re-create the rule.   

Using the Translations Tab to Select Record Identifiers 
In the Translations tab, you associate change-controlled fields with other fields that 
identify the individual record to which changes apply. The values you select here are 
valid for any fields in the block you selected under the Change Element tab. For ex-
ample, if you were to apply change control to a field that provides information about 
vendors, you would use the Translations tab to specify a field or fields that identify a 
vendor whose record has changed. 
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Click on the Translations tab and fill in the following values. 
• Display Prompt: Type a name for the record-identifying field. When a user 

changes a controlled field, he may (depending on the control type applied to 
the field) complete a Change Request form (see page 15). The Display 
Prompt value appears as a label in that form. (In the illustration on page 16, 
it’s the label Vendor Name near the top of the Change Request form.) 

• Display Column (Block.Field): Select the name of the field you want to use 
for record identification. Use the format BLOCK.FIELD, in which BLOCK is the 
name by which underlying code recognizes the form block that contains the 
field you want to use, and FIELD is the name by which underlying code calls 
the field you want. The block does not have to match the block you specified 
under the Change Element tab. 

• Table Name: Select the name of the database table that corresponds to the 
block you specified under the Change Element tab. If you have not used Ora-
cle Audit to include the table in an audit group (see page 2), ACTIVE Data 
Governor presents an error message, and you cannot complete the procedure. 
You must close the AppsControl Wizard, use Oracle Audit to enable auditing 
for the column, and then return to Wizard to start over. 

• Primary Keys: Click on the Import Primary Keys button. Under the label Pri-
mary Key Columns, the AppsControl Wizard lists primary keys for the table you 
selected in the Table Name box. You cannot change these values. 

• Form Field: For each database column name entered under the Primary Key 
Columns label, type the name of the corresponding form field. Once again, 
use the format BLOCK.FIELD, in which BLOCK is the name by which underly-
ing code recognizes the form block that contains the field, and FIELD is the 
name by which underlying code calls the field you want. 

Creating Reason Codes 
When a field is assigned the Reason Code or Approval control type, a user who 
makes a change to the field must use a Change Request form to select a reason for 
the change. Each reason is one in a group of codes assigned to the field.  
To create both reason codes and the groups to which they belong: 
1 Click on Tools in the Oracle Applications menu bar, then on AppsControl Rea-

son Code in the Tools menu. An AppsControl Reason Code form appears: 
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2 Create the reason-code group. Fill in these boxes: 
• Reason Type: Type a name for the group to which reason codes are to 

belong. This value is available for selection in the Reason Type box of the 
Change Details grid (page 6). 

• Description: Type a description for the group of reason codes. 
3 Create reason codes that belong to this group of codes. Devote each row of the 

Reason Code grid to one code. Fill in these boxes: 
• Reason Code: Type a unique name for a reason code. This will appear in the 

list of values in the AppsControl Change Request form. 
• Reason Description: Type a description of the code you have created. 
• Enabled Flag: Select the checkbox to put the reason code into effect. Clear 

the checkbox to disable the reason code. 
4 Save the reason codes: Select File from the Oracle Applications Menu bar, then 

Save from the File menu. 
5 Close the AppsControl Reason Code form: Click on the × symbol in its upper 

right corner. 
To open an already existing group so that you can modify or add to its reason codes: 
1 Open the Reason Code form: Click on Tools in the Oracle Applications menu 

bar, then on AppsControl Reason Code in the Tools menu. 
2 Click on View in the menu bar, then on Query by Example in the View menu, 

and then on Enter in the Query submenu. 
3 The Reason Type and Description boxes in the Reason Code form turn blue. In 

these boxes, type enough information to identify uniquely the group you want to 
open. (Typically, the name of the group in the Reason Type box is sufficient.) 

4 Click on View in the menu bar, then on Query by Example in the View menu, 
and then on Run in the Query submenu. 

Finishing the Control-Rule Generation 
When you complete the foregoing configuration tasks for any number of fields, you 
can generate rules that implement your work: 
1 Click on the Change Details tab in the bottom grid of the Change Element form. 
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2 Select the Generate check box for each of the rows for which you want to gen-
erate rules. Or, select the All check box (at the upper right of the Change Details 
panel, in the Generate column) to choose all rows displayed in the panel. 

3 Click on the Generate Selected Rules button. 

4 Click on the Yes button in each of two pop-up messages. (One confirms that 
you want to create the selected rules, and the other informs you that all existing 
rules will be deleted and then recreated.) 

5 Click on Tools in the Oracle menu bar, then on Compile Audit Objects in the 
Tools menu. Verify that the process has run successfully under View/Reports. 

6 Click on the Rules tab to review information about the rules you have generated, 
which varies according to control type: 

 
• The Rule Name field displays a name for the rule, but is populated only for 

the Reason Code and Approval control types. 

• The Process Name field identifies the workflow process that sends notifica-
tion of a change to a reviewer. It’s always populated for an Approval rule, is 
populated for a Reason Code rule only if a value for that rule is entered in the 
WorkFlow Role field of the Change Details tab, and is never populated for 
an Audit rule. 

• The Audit field displays the name of the audit group that applies to the con-
trolled field. (ACTIVE Data Governor can use the Oracle Applications audit-
ing feature to perform auditing at the database level. The controlled field cor-
responds to a database column; the column exists in a database table; and for 
changes to columns in a table to be tracked, the table is placed in an audit 
group.) This field is populated for all three control types. 
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Uploading or Migrating Control Rules 

ACTIVE Data Governor includes a “content spreadsheet,” which contains more 
than 1,500 fully configured change-control rules. Your Professional Services repre-
sentative reviews this spreadsheet with you to determine which rules are appropriate 
for your site.  

Whether you upload rules from a content spreadsheet or create them individually in 
the AppsControl Wizard, you can “migrate” them — copy them from one Oracle 
Applications instance to another.  

In either case, you make use of concurrent requests: 

1 Log on to the LogicalApps responsibility in the Oracle E-Business Suite.  

2 Click on View in the menu bar, then on Requests in the View menu. 

3 A Find Requests form opens. Click on its Submit a New Request button. In the 
Submit a New Request dialog, click on Single Request and then on the OK button. 

4 A Submit Request form opens. In its Name list of values, select the concurrent 
request you want. 

5 A Parameters form appears. Supply parameter values and click on the OK button. 
(Parameters vary by request; some are required and others optional. See the de-
scription of each request for a discussion of its parameters.) 

6 In the Submit Request form, click on the Submit button. At the next prompt, note 
the request number, and then click on No to return to the Find Requests form. 
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7 If you choose to view a request log, click on the Specific Requests button. Type 
the ID number for your request in the Request ID field, and click on the Find 
button. A Requests form opens; click on its View Log button. 

Uploading Rules from a Content Spreadsheet 
To upload rules from a content spreadsheet, first review and prepare them: 

1 Review the spreadsheet with your Professional Services team member. Select the 
rules that target fields for which you want to implement controls. Type the letter 
Y in the Upload column for each of these rules. 

2 Create a flat file containing the rules you’ve selected: From the Tools menu in 
Excel, select the Create CSV for AppsControl option. Specify the destination for 
the CSV file and select the Save button. 

Note 
The Create CSV for AppsControl option appears in the Excel Tools menu 
only if the macro security level for Excel is set to low. To effect this set-
ting, click on Tools in the Excel menu bar, then on Options in the Tools 
menu. In the Options window, click on the Security tab. In the Security 
panel, click on the Macro Security button. A Security window opens; in 
its Security Level panel, click on the Low radio button. Then close the 
Security and Options windows — click on the OK button in each. 

3 A control total message displays the number of rules written. To verify the com-
pleteness of your upload file, compare this with the number of rows you selected. 

Each of the rules you selected applies control to a form field, and each field corre-
sponds to a database column. Each field resides on a form block, and each block 
corresponds to a database table. Before you upload rules from the CSV file you’ve 
prepared, you must use Oracle Audit to create audit groups that include all database 
tables affected by your rules, and to enable auditing for all columns affected by your 
rules. If auditing is not set up for a column or table used by even one rule, then all 
rules in your CSV file will fail to load. 

To upload the file you’ve prepared: 
1 FTP the CSV file to the /usr/tmp UNIX directory of the instance in which the 

rules are to be used. 
2 Run the LA AppsControl Data Load concurrent request. Supply the following 

parameters: 
• File Name: Type in the name of the CSV file. This parameter is mandatory. 
• File Location: Type in the UNIX path to the CSV file. This parameter is 

mandatory. 
• Debug Mode: Select Yes to enable debug functionality for the load, or No to 

disable the functionality. 
• Load Data: Select Yes if the data is to be loaded into the ACTIVE Data Gov-

ernor rule repository. Select No if this is a data validation run only. 
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3 Open the AppsControl Wizard (page 3). Click on Tools in the menu bar, then on 
AppsAudit Compile Audit Objects in the Tools menu. A pop-up note informs you 
of a concurrent request ID number. Click on the OK button to clear the 
message. 

Migrating Control Rules 
The method you use to copy control rules from one instance to another depends upon 
whether you have modified them in the source instance: 

• If you have uploaded rules from a content spreadsheet to a source instance and 
have neither changed them nor added rules to them, simply upload the same rules 
from the content spreadsheet to the destination instance. 

• If you have used the AppsControl Wizard either to create rules or to modify 
rules uploaded from a content spreadsheet, run a concurrent request called LA 
AppsControl Data Export. This request takes the following parameters: 

– File Location: Type in the UNIX path to the export file you are creating. 
This parameter is mandatory. 

– File Name: Type a name for the export file you are creating. This parameter 
is mandatory. 

– Application: Select one Oracle Application to export rules associated with 
that application, or leave the parameter blank to export rules associated with 
all applications. 

– Form: This parameter is available only if you have made a selection for the 
Application parameter. Select a form used by the application to export only 
control rules associated with that form, or leave the parameter blank to export 
rules associated with all forms. 

– Block: This parameter is available only if you have made a selection for the 
Form parameter. Choose a block that belongs to the selected form to export 
only control rules associated with that block, or leave the parameter blank to 
export rules associated with all blocks. 

– Table: This parameter becomes available only if you have made a selection 
for the Block parameter. Choose the database table that corresponds to the 
selected block, or leave the parameter blank. 

– Field: This parameter becomes available only if you have made a selection for 
the Table parameter. Choose a form field that belongs to the selected block 
(and for which data is stored in the selected table) to export only the single 
control rule for that field, or leave the parameter blank to export control 
rules for all fields on the block. 

– Control Type: Select one of the three control types to export only rules that 
implement that control type, or leave the parameter blank to export all types 
of rules. 
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– Enabled Flag: Select Yes to export only those rules for which the Enabled 
Flag check box (page 7) is checked; Select No to export only those rules for 
which the Enabled Flag check box is cleared; or leave the parameter blank to 
export rules configured in both ways. 

Then, use the file you create to run the LA AppsControl Data Load concurrent 
request on the destination instance. (Follow the procedure described in “Upload-
ing Rules from a Content Spreadsheet,” page 12.) 
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Chapter 4 

Applying Changes to Controlled Fields 

When you enter or modify data in an Oracle Applications field that is subject to change 
control, the process you follow depends on the control type assigned to the field. 

Audit 
If a field is under Audit change control, any change you make is captured and avail-
able for reporting. However, you need not select a reason code or obtain an approval, 
so there is no change to your ordinary procedure. Fields under Audit change control 
are not distinguished visually from fields that are not subject to change control. 

Reason Code or Approval 
Depending on your visual-attributes selections (see page 7), a field subject to Reason 
Code or Approval change control may appear in bright yellow on its Oracle Applica- 
tions form.  

ACTIVE Data Governor may handle changes to the values of these fields in either 
of two ways, depending on whether the fields exist on a form associated with a When 
Validate Record event, and therefore whether the WVR Enabled check box in the 
AppsControl Wizard is selected for each block of the form (see page 6).  

• If so, ACTIVE Data Governor allows the user to make changes to the fields, but 
imposes the controls when the user attempts to save the changes. The user would 
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open a Change Request form to offer reasons, and if appropriate to begin the ap-
proval process, for all the changed fields at once. 

• If not, ACTIVE Data Governor write-protects the controlled fields, and a user 
cannot make changes to them directly. For each field, the user would instead open 
the Change Request form and enter the new field value there — as well as offer a 
reason for the change and, if appropriate, initiate the approval process. In this 
case, the user can modify only one field at a time in the Change Request form. 

Change Control with WVR Enabled 
To change the values of controlled fields on a form associated with the When Vali-
date Record event: 

1 Enter new values in any number of controlled fields as you ordinarily would. 

2 Save the changes: Click on file in the menu bar, and then Save in the File menu. 
Or, click on the Save button, located fourth from the left in the tool bar. 

3 The following message appears. Click on the OK button to clear it. 

 
4 Click on Actions in the Oracle Applications menu bar, then on AppsControl 

Change Request in the Actions menu. The following form appears: 

 
The form devotes a row to each of the changes you are making (and, in other 
rows, displays information on changes made in prior sessions). In each row that 
applies to a new change, most of the fields provide information but do not accept 
input. These include User Field Name, Original Value, New Value, Request Date, 
Requested By, and Status. 

5 In each row that applies to a new change, click in the Reason field to select a 
reason from a list of those configured for the field. 

6 In the Comments text box, you may add any comments you deem appropriate. 
These comments appear on the Change History Report (see page 21). The Com-
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ments text box displays information specific to whatever row you’ve selected in 
the grid — it presents an already-recorded comment for an old change or, for a 
new change, it clears so that a new comment may be entered. 

7 Click on the Done button. 

Change Control with WVR Disabled 
To change the values of controlled fields on a form that is not associated with the 
When Validate Record event: 

1 Select (click on) a controlled field whose value you want to change. Note that if 
you try to enter a value in the field, the status bar near the bottom of the screen 
displays the message “Field is protected against update.” 

2 With the field selected, click on Actions in the menu bar, and then on AppsControl 
Change Request in the Actions menu. 

• If you are attempting to modify a list of values, its Find form opens, present-
ing a selection of entries appropriate for the field. Click on one and on the 
OK button. The Change Request form then opens and displays your selection 
in the New Value field. 

• If you are attempting to modify a data-entry field, the Change Request form 
opens immediately, and the New Value field is blank. Type the value you want 
in the New Value field. 

In either case, some fields provide information but do not accept input. These 
include User Field Name, Original Value, Request Date, Requested By, and Status. 

3 Click in the Reason field to select a reason from a list of those configured for the 
field. 

4 In the Comments text box, you may add any comment you deem appropriate. 

5 Click on the Done button. 

6 Repeat this process for each controlled field you want to change. When you fin-
ish making changes, save your work: Click on file in the menu bar, and then Save 
in the File menu. Or, click on the Save button, located fourth from the left in the 
tool bar (it looks like a disk). 

Completing the Approval Process 
If you are working with a field assigned the Reason Code control type, the process of 
changing the field value is complete. (You can still undo such a change: reopen the 
Change Request form, select the row that represents the change, and click on the 
Reject button.) 

If, however, the field was assigned the Approval control type, the status of the change 
remains pending (as shown in the Status column of the Change Request form), and 
you cannot make further changes to the field until the pending change is approved 
or rejected. An approval decision involves the following additional steps: 
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1 When you close the Change Request form, the following message appears, inform-
ing you that the approval workflow process has begun. Click the OK button to 
clear it. 

 
2 The individual (or workflow role) assigned to approve the change receives a noti-

fication that the change is pending. 

 
3 The user clicks on the notification to open it. He reviews the information and 

optionally adds a comment: 

 
4 The user also clicks one of the following buttons: 

• Approve: A notification of the approval is sent to the original requester, who 
must acknowledge the acceptance. 

• Reject: The change cannot be made. 

• Reassign: The decision to approve or reject is reassigned to another user. 

In the case of approval, the field-value change is not made until the original requester 
acknowledges the approval. This user opens the form on which the field appears, 
selects the field, and receives a dialog box offering the option to update the field. If 
the requester clicks on the Yes button, the field is updated. If the user selects the No 
button, the change is postponed, but not cancelled. Eventually the requester must 
select the Yes button because the change has been approved.
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Chapter 5 

Viewing Reports 

In ACTIVE Data Governor, three reports offer information about control-rule 
configuration, the changes made to the fields those rules control, and the resolution 
of changes that require approval: 

• The Approver Performance Report provides statistics about the numbers of 
approvals, rejections, and pending decisions, and the time required for decisions, 
for each person authorized to approve changes. 

• The Change History Report shows the old and new value for each change made 
to each field subject to change control, as well as information about the control 
rule affecting the field and the circumstances surrounding each change 

• The Control Listing Report displays configuration details for a user-specified selec-
tion of control rules, organizing them first by application and then by responsibility. 

To view the reports, open them in the ACTIVE Governance Platform. First, start 
the Platform; unlike the AppsControl Wizard, it is a web-based application designed 
to run in Microsoft Internet Explorer. (It may run in other web browsers as well, but 
only Internet Explorer is supported.)  

1 Open Internet Explorer. 

2 In the Address field, type the URL for your instance of the ACTIVE Govern-
ance Platform, and press the Enter key. (Using standard Windows procedures, 
you can save the URL as a favorite or create a desktop shortcut to the URL.) 

3 A Sign In dialog box appears. Type your user name and password in the appro-
priate fields, and click on the Sign In button. 
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4 The ACTIVE Governance Platform opens. In it, click on the Reporting tab. 

5 A Folders area to the left of the Reports panel presents a hierarchical display of 
available reports and the folders that contain them. In it, click on Public Folders, 
then Report Center, and then AppsControl: 

 
6 In the larger panel on the right, click on the link for the report you want. You 

will be prompted to enter parameter values. Because parameters vary by report, 
appropriate values for most of them are discussed in the report descriptions that 
follow.  

Approver Performance Report 
The Approver Performance Report provides statistics about the numbers of 
approvals, rejections, and pending decisions, as well as the time field-value change 
requests have spent in the system. As you generate the report, you can select the 
following parameters: 

• AppsRules Source Data: Select the Oracle Applications instance that that 
contains control rules about which the report should present information. (You 
supply this value twice, first to generate a list of the remaining parameters and 
second, within that list, to generate the report itself.) 

• Application: Select any number of, or all, application names for the report to list 
changes to fields accessible from the applications you choose. 

• Approved By: Select any number of, or all, workflow roles with authority to 
approve or reject field-value changes. and the report lists controlled fields subject 
to those approvers’ judgment. You can select only approvers named in rules that 
apply to the fields accessible from the application you chose in the previous 
parameter. 
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• Date Range: Select beginning and ending dates to view approval statistics for 
changes within the range you specify. 

Change History Report 
The Change History Report shows the old and new value for each change made to a 
field subject to change control. It also shows such information as the user who made 
the change and, if applicable, the user who approved it; the dates of the change and 
the approval; the control type of the rule that implements change control; the change 
status; reason code, again if applicable; and any comments. As you generate the 
report, you can select the following parameters: 

• AppsRules Source Data: Select the Oracle Applications instance that that 
contains control rules about which the report should present information. (You 
supply this value twice, first to generate a list of the remaining parameters and 
second, within that list, to generate the report itself.) 

• Application: Select any number of, or all, application names for the report to list 
changes to fields accessible from the applications you choose. 

• User Form Name: Select any number of, or all, form names to have the report 
list changes to fields that appear in the forms you choose. You can select only 
forms available in the applications you selected in the previous parameter. 

• User Field Name: Select any number of, or all, field names to have the report list 
changes to the fields you choose. You can select only fields available in the forms 
you selected in the previous parameter. 

• Record Identifier: Select any number of record identifiers (see page 7) to see 
changes associated with the identified records. You can select only identifiers 
appropriate to the fields you selected in the previous parameter. 

• Control Type: Select any combination of Audit, Reason Code, and Approval to 
view changes to fields that are subject to rules of the control types you select. Or, 
select All to list fields subject to rules of any control type. 

• Request Date: In the Start of Range and End of Range fields, select beginning 
and ending dates to view changes within the range you specify. 

• Notification to/Approved By: Select one or more user names to view changes 
for which those users are the approvers (for fields subject to Approval rules) or 
the recipients of notifications (for fields subject to Reason Code rules). Or select 
All to view changes for which anyone (or no one) may be an approver or 
notification recipient. 

• Approval Status: Select any combination, or all, of Approved, Closed, Pending, 
or Rejected to have the report list changes currently at the selected statuses. 

• Requested By: Select one or more user names to view changes made by those 
users, or select All to view changes made be all users. 
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Control Listing Report 
The Control Listing Report provides information about the fields that are subject to 
control rules. As you generate the report, you can select the following parameters: 

• AppsRules Source Data: Select the Oracle Applications instance that that 
contains control rules about which the report should present information. (You 
supply this value twice, first to generate a list of the remaining parameters and 
second, within that list, to generate the report itself.) 

• Application: Select any number of, or all, application names for the report to list 
controlled fields that apply to the applications you choose. 

• User Form Name: Select any number of, or all, form names to have the report 
list controlled fields that appear in those forms. 

• Workflow Role: Select any number of workflow roles to have the report list 
fields subject to Approval or Reason Code rules that name the selected workflow 
roles as reviewers. 

• Control Type: Select any combination of Audit, Reason Code, and Approval to 
focus the report on fields that are subject to rules of the control type you select. 
Or, select All to list fields subject to rules of any control type. 

• Control Status: Select Active or Inactive to have the report list fields whose 
controls are either enabled or disabled, or select All to have the report list both 
types. 

• Print Comments: Select Y to have the report include, for each field it lists, the 
comment configured for the control rule to which the field is subject. Or, select 
N to exclude comments. 

• Include Graph: The report can display data not only textually, but also graphi-
cally. Select Y to include, or N to exclude, graphs in a report. 

• Enter Report Output: Select Print to produce report output in a document 
format, or Export to produces report output in a tabular format. 
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Appendix A 

Creating Workflow Roles 

You must assign workflow role to each Approval control rule you configure, and you 
may assign one to each Reason Code rule; the role specifies one or more people who 
may, depending on the control type, by notified of a field-value change or be required 
to approve or reject it.  

To create a workflow role, log  on to an application called LogicalApps AppsFlow, 
which runs within the Oracle ERP environment: 

1 Log on to Oracle Applications. 

2 Select the LogicalApps responsibility in the Oracle Application list. (Ensure first 
that the LogicalApps responsibility is available to you.) 

3 A selection of LogicalApps applications appears. Click on the AppsRules option. 

4 In the AppsRules form, click on the AppsFlow tab.  

For the purposes of ACTIVE Data Governor, your only interest in AppsFlow is to 
create workflow roles. To do so, you use one option available from the menu bar; 
you can ignore the AppsFlow form. 

To create a workflow role: 

1 Click on AppsFlow in the menu bar, and then on AppsFlow Define Roles in the 
AppsFlow menu. An Approval Roles form opens (as shown at the top of the next 
page). 

2 In the Role field, type a unique name for the role. 
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3 In the Description field, type a brief explanation for the purpose of the role. 

4 In the Display Name field, create an easily recognizable name for the role. This is 
the name you will be able to select in the AppsControl Wizard. 

5 In the Status list box, select Active to place the role into use or Inactive to 
remove it from use. Note that once you inactivate a role, you cannot reactivate it. 

6 In the Notification list of values, select the format in which members of the role 
will receive notifications. 

7 In the Expiration Date field, enter a date on which the role expires, or leave the 
field blank to allow the role to exist indefinitely. Select a date in the pop-up cal-
endar that appears when you click on the list-of-values icon. Or type a date in the 
format configured for your instance of Oracle Applications. 

8 In the User list, select users, responsibilities, or other roles to be included in this 
role 

When you finish configuring a workflow role, save it: click on File in the menu bar 
and Save in the File menu. When you finish working in the Approval Roles form, 
click the Done button to close it. 
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Appendix B 

Using the Event Tracker 

The Event Tracker, a feature available in an application called LogicalApps AppsForm, 
gathers information about forms, blocks, and fields in Oracle Applications. Once the 
Event Tracker has been run in forms containing fields you want to control, ACTIVE 
Data Governor can present appropriate information for selection in the AppsControl 
Wizard as you create control rules.  

To use the Event Tracker, create a rule in AppsForm. A typical AppsForm rule 
consists of “elements,” each of which targets a form, block, or field and specifies an 
event that triggers processing. Each element then defines customizations to the tar-
get form, block, or field. In this case, however, the rule exists only to enable you to 
run the Event Tracker, which is one of the events an element can specify. So the rule 
will consist of one element for each Oracle Applications form that contains fields 
you want to place under change control, but it won’t define any customizations. 

To run the Event Tracker: 

1 Log on to Oracle Applications. 

2 Select the LogicalApps responsibility in the Oracle Application list. (Ensure first 
that the LogicalApps responsibility is available to you.) 

3 A selection of LogicalApps applications appears. Click on the AppsRules option. 

4 In the AppsRules form, ensure that the AppsForm tab is selected (as shown in 
the figure at the top of the next page.) This should be the default. 
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5 Type a name for the rule in the Rule Name field. 
6 In the Description field, briefly explain the purpose of the rule. 
7 Ensure that the Active check box is selected. 
Once the rule itself is named and described, you can create rule elements, one per 
row in the Rule Elements grid: 
1 In the Seq field, type a number. 
2 In the Element Name field, type a name for the element. 
3 Specify the form that is the target of the element. Do either of the following: 

• In the Form Name field, select the internal name for the form. AppsForm 
then supplies a corresponding value in the User Form Name field. 

• In the User Form Name field, select the “user friendly,” external name for the 
form. AppsForm then supplies a corresponding value in the Form Name field. 

4 In the Event list of values, select the value Event Tracker. 
5 Ensure that the Active check box is selected. 
6 Repeat steps 1–4 for all forms containing fields for which you expect create 

change-control rules in ACTIVE Data Governor. 
7 Save the rule: click on File in the menu bar, then on Save in the file menu. 
8 Refresh the AppsRules cache: One way is to close AppsForm. Another is to click 

on Tools in the menu bar and AppsRules Configuration in the Tools menu. An 
AppsRules Configuration window opens; in it, click on the Refresh Cache button. 

Once the elements are configured, the rule is saved, and the cache is refreshed, open 
each Oracle Application containing forms you chose. Navigate to each form and, in 
it, navigate to each field you want to control. Create or update a record and save your 
work. By doing so, you capture a reference to each item you touch, and these items 
become available in the AppsControl Wizard.  
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